6A HP Color LaserJet 4550N Printer

6A.1 Overview

This appendix is designed to provide maintainers with the information necessary to support the HP Color LaserJet 4550N Printer.  This appendix identifies the printer’s Line Replaceable Units (LRUs) as well as the LRU’s controls and indicators.

The OASIS Flight Data Server Subsystem equipment includes a HP Color LaserJet 4550N Printer or a HP Color LaserJet 4600 Printer, both supports printing high quality color graphics on plain copier-grade paper for the AFSS Workstation Subsystem.  The HP Color LaserJet 4550N comes standard with 64 MB RAM and an HP JetDirect 610N print server Enhanced Input Output (EIO) network card for connecting to a network.  For further detailed information on the Color Printer XE "Color Printer" , refer to the Hewlett Packard Color LaserJet 4550N Printer User Manual.

6A.2 HP Color LaserJet 4550N Printer LRUs

The HP Color LaserJet 4550N Printer LRUs and consumables are described in Table 6A-1.

Table 6A‑1.  HP LaserJet 4550N Printer LRUs and Consumables

	Hardware Item
	Description

	Color Printer
	HP Color LaserJet Printer 4550N


	Consumable
	Relative Printer Message

	Black Toner Cartridge
	BLACK TONER LOW or BLACK TONER OUT

	Cyan Toner Cartridge
	CYAN TONER LOW or CYAN TONER OUT

	Magenta Toner Cartridge
	MAGENTA TONER LOW or MAGENTA TONER OUT

	Yellow Toner Cartridge
	YELLOW TONER LOW or YELLOW TONER OUT

	Drum Kit
	DRUM LIFE OUT REPLACE KIT or WASTE TONERFULL REPLACE KIT

	Transfer Kit
	TRANSFER LIFE OUT REPLACE KIT

	Fuser kit
	FUSER LIFE OUT REPLACE KIT


6A.3 HP Color LaserJet 4550N Printer Controls and Indicators

The HP Color LaserJet 4550N’s front and rear panel controls and indicators are shown in Figure 6A-1 and Figure 6A-2 and described in Table 6A-2 and Table 6A-3.  The rear panel Diagnostic Indicators are described in Table 6A-4.

CAUTION:  If needing to ship the printer, remove the toner cartridges and imaging drum before shipping.

6A.3.1 Controls and Indicators

Front View

The front panel controls and indicators are shown in Figure 6A-1 and described in Table 6A-2.
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Figure 6A-1.  LaserJet 4550N Printer Controls and Indicators– Front View

Table 6A‑2.  LaserJet 4550N Printer Controls and Indicators– Front View

	Item
	Description

	1
	Top output bin

	2
	Printer control panel

	3
	Power switch (standby button)

	4
	Optional duplex printing accessory drawer

	5
	Tray 3 (optional 500-sheet paper feeder)

	6
	Tray 2 (250 sheets of standard paper)

	7
	Middle front drawer (transfer belt access)

	8
	Tray 1 (150-sheet multipurpose tray)

	9
	Upper front drawer (imaging drum access)

	10
	Top cover door release button

	11
	Top cover door (toner cartridge access)


Rear View

The rear panel controls and indicators are shown in Figure 6A-2 and described in Table 6A-3.
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Figure 6A-2.  LaserJet 4550N Printer Controls and Indicators– Rear View

Table 6A‑3.  LaserJet 4550N Printer Controls and Indicators– Rear View

	Item
	Description

	1
	Rear door (fuser access)

	2
	Rear output bin door

	3
	Optional duplex printing accessory cover

	4
	Optional duplex printing accessory power receptacle

	5
	Printer power receptacle

	6
	Parallel connector (“C” connector)

	7
	EIO slots

	8
	Paper handling accessory port

	9
	Memory access (remove the formatter)

	10
	FIR port


Control Panel

The Control Panel controls and indicators are shown in Figure 6A-3 and described in Table 6A-4.
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Figure 6A-3.  LaserJet 4550N Printer Control Panel Controls and Indicators

Table 6A‑4.  LaserJet 4550N Printer Control Panel Controls and Indicators

	Item
	Description

	1
	Attention LED (Amber) – On, a critical error has occurred. Printer requires attention.

Off, no conditions exist that require attention.

Flashing, an error has occurred.  Printer requires attention.

	2
	Menu Rocker key - Displays a menu system for obtaining printer status information or changing the printer’s configuration settings.

	3
	Item Rocker key - Cycles through items in the selected menu.  Menu items vary depending on the options installed and on the configuration of other menu choices.  The ITEM key is also used to navigate through the printer’s online Help system.

	4
	Printer online Help

	5
	Value Rocker key - Cycles through the value choices for a particular menu item.

	6
	Select key - Selects the value that is currently shown on the display.

	7
	Cancel Job key - Terminates the job that is currently printing.  The printer completes the current page and purges all input until a new job is detected (may take several seconds depending on the size of the job).

	8
	Go key - Depends on the status of the printer.  Normally, GO activates printing using current settings or directs the printer to proceed with the process designated on the control panel.  If the printer is offline, pressing GO will return the printer to the READY state.

	9
	Data LED (Green) – On, processed data is present in the printer, but more data is needed to complete the job.

Off, no data is being received or processed.

Flashing, data is being received and processed by the printer.

	10
	Ready LED (Green) – On, printer is online (able to accept and process data).

Flashing, printer is offline.

Off, printer is attempting to stop printing and go offline.

	11
	Printer control panel display


NOTE:  The Item Rocker key is also used to navigate through the online [?] Help system.

6A.3.2 Setup/Configuration

The Color Printer configuration and setup parameters can be set or changed through the Control Panel Menus.  Memory Maps are provided to aid the user when navigating through the various Control Panel Menus.  A sample Menu Map is shown in Figure 6A-4 and described in Table 6A-5.

NOTE:  In the menu descriptions, menu items followed by an asterisk (*) denote default values.
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Figure 6A-4.  Sample Memory Map

Table 6A‑5.  Memory Map Description

	Item
	Name
	Description

	1
	Information Menu
	The Information Menu selections are used for accessing and printing specific printer information.

	2
	Paper Handling Menu
	The Paper Handling Menu allows you to configure input trays by size and type.  This menu can also be used to set the default media size and type.

	3
	Printing Menu
	The Printing Menu is used to set default settings for a specific print job.

	4
	Configuration Menu
	The Printing Menu is used to set default settings for a specific print job.

	5
	I/O Menu
	The I/O Menu allows you to make changes to printer interface settings.

	6
	Calibration Menu
	This printer features automatic, internal calibration to produce optimum color for most print jobs.  The Calibration menu provides fine-tuning for critical color-matching requirements.

	7
	Resets Menu
	The Resets Menu is used for resetting the printer memory and for returning the printer to its factory default settings.  It is also used to clear maintenance messages following the replacement of certain consumable items.

	N/A
	Quick Copy Jobs Menu (only shown if a hard disk or RAM disk is installed)
	This menu provides a list of the quick copy jobs stored on the printer hard disk.  The user can print or delete these jobs from the control panel.

	N/A
	Private/Stored Jobs Menu (only shown if a hard disk or RAM disk is installed)
	This menu provides a list of the private and stored jobs on the printer’s hard disk.  The user can print or delete these jobs from the control panel.


6A.3.2.1 To print a Menu Map

1.
On the printer Control Panel, <Press> MENU until ‘INFORMATION MENU” displays.

2.
<Press> Item until “PRINT MENU MAP” displays.

3.
<Press> Select to print the Menu Map.  After printing the Menu Map, the printer will return to the READ state.

6A.3.2.2 To print a Configuration Page

Printing a printer Configuration Page can help the user verify that the printer is configured properly.  This can be useful in troubleshooting printer problems.

1.
On the printer Control Panel, <Press> MENU until ‘INFORMATION MENU” displays.

2.
<Press> Item until “PRINT CONFIGURATION” displays.

3.
<Press> Select to print the Configuration Page.  After the process is completed, the printer will return to the READ state.

Note:  If the printer is configured with EIO cards or an optional hard disk drive, an additional configuration page will print that provides interface configuration information.

6A.3.2.3 To print a Supplies Status Page

The supplies status page illustrates the remaining life for the following printer consumables and kits:

· Toner Cartridges (all colors)

· Drum Kit

· Transfer Kit

· Fuser Kit

It also lists useful printer information including the total number of pages printed (in monochrome and in color), the printer serial number, and the part numbers for the supplies.

1.
On the printer Control Panel, <Press> MENU until ‘INFORMATION MENU” displays.

2.
<Press> Item until “PRINT SUPPLIES STATUS PAGE” displays.

3.
<Press> Select to print the Supplies Status Page.  After the process is completed, the printer will return to the READ state.

6A.3.2.4 To set the IP Address for Network communications

The OASIS equipment uses common IP addressing schemes from site to site.  The first 3 fields of an IP Address represent a Site ID, and the last field is used to designate a specific piece of site equipment.  The IP Address for the Color Printer are designated as follows:

· IP Address  -  xxx.xxx.xx.11, where the x’s represents a Site ID.

Print a Configuration Page to check the IP Address of the Color Printer.  Refer to Appendix A for specific site and equipment IP address information.

Perform the following steps from the Control Panel of the HP 4550 Printer after the toner cartridge has been inserted, the printer is powered up, and READY appears on the printer display:

1.
<Press> Menu, until "EIO2 JetDirect" appears. 

2.
<Press> Item ( and CFG NETWORK = NO appears. 

3.
<Press> the Value + key to change CFG NETWORK to YES.

4.
<Press>  Select. 

5.
<Press> Item ( 
6.
<Press> Value + to change IPX/SPX to OFF
7.
<Press> Select
8.
<Press> Item (
9.
<Press> Value + to change DLC/LLC to OFF
10.
<Press> Select
11.
<Press> Item ( twice

12.
<Press> Value + to change ATALK to OFF
13.
<Press> Select
14.
<Press> Item (
15.
<Press> Value + to change CFG TCP/IP to YES
16.
<Press> Select
17.
<Press> Item (
18.
<Press> Value + to change BOOTP to NO
19.
<Press> Select
20.
<Press> Item (
21.
<Press> Value + to change DHCP to NO
22.
<Press> Select
23.
<Press> Item (
24.
<Press> Value + or - to change IP Byte 1 to xxx   (where xxx = first octet of site IP)

25.
<Press> Select
26.
<Press> Item (
27.
<Press> Value + or - to change IP Byte 2 to xxx   (where xxx = second octet of site IP)

28.
<Press> Select
29.
<Press> Item (
30.
<Press> Value + or - to change IP Byte 3 to xxx   (where xxx = third octet of site IP)

31.
<Press> Select
32.
<Press> Item (
33.
<Press> Value + or - to change IP Byte 4 to 11
34.
<Press> Select
35.
<Press> Item ( until EIO2 Jet Direct appears

36.
<Press> Menu until Ready appears

To verify that the printer has been configured correctly, perform the following procedure from NT Server 1 or 2 

1.
<Select> Start>Settings>Printers
2.
<Select> the CPRINTER icon, then right mouse click and <Select> Properties
3.
<Click> on “Print test page”

4.
Did the test page print correctly? <Click> on YES or NO
5.
Close CPRINTER Properties
6A.3.2.5 To verify the IP Address and Network communications

1.
At the Backup NT Server, use the Start button to <Select> Start>Programs>Accessories>Command Prompt to open a DOS Window.

2.
At the “C:\>” prompt, <Type> ping xx.xxx.xxx.11 (where the x’s represents the Site address and .11 is the IP address for the Color Printer).


The system should reply a number of times with the correct IP Address.  If the system responds with a “timeout”, recheck the IP Address and the Network connections.

3.
Print a “Configuration Page” to verify the IP Address, if necessary.

6A.3.2.6 Printing a Consumables Report

1.
<Press> MENU on the Control Panel until “INFORMATION MENU” appears on the Control Panel Display.

2.
<Press> -( until “PRINT SUPPLIES STATUS PAGE” appears in the Control Panel Display.

3.
<Press> Select to print a Supplies Status Page.   (Approximately 30 seconds).

6A.3.3  XE "Maintenance" Maintenance Procedures

This section contains the following three categories of Maintenance Procedures:

· Preventive Maintenance Procedures

· Remove and Replace the Printer consumables

· Remove and Replace the Printer. 

Preventive Maintenance
To maintain high print quality and performance, thoroughly clean the printer an the paper handling accessories:

· Whenever the toner cartridge is changed (run a few pages through afterwards). 

· After printing approximately 6,000 pages for cyan, magenta, and yellow (CMY) and 9,000 pages for black. 

· Whenever print quality problems occur.

Clean the printer and the paper handling accessories in accordance with Table 6A-6.
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WARNING:  Before beginning these steps, turn off the printer and unplug all power cords to avoid shock hazard.  Use caution when cleaning around the fusing assembly area - it may be hot.

CAUTION: To avoid permanent damage to the toner cartridge, do not use ammonia-based cleaners on or around the printer.  Do not touch the transfer roller.  Skin oils on the roller can reduce print quality.  If toner on clothing, wipe it off with a dry cloth and wash in cold water.  Hot water sets toner into fabric. 

Table 6A‑6.  Printer and Paper Handling Accessories Cleaning

	Component 
	Cleaning Method

	Outside Covers
	Use a water-dampened cloth. Do not use solvents or ammonia-based cleaners.

	Inside General
	With a dry, lint-free cloth, wipe any dust, spilled toner, and paper particles from the paper path area, the registration roller, and the toner cartridge cavity.

	Paper Pickup, Feed, and Separation Rollers
	Use a water-dampened, lint-free cloth.

	Separation Pad
	Use a dry, lint-free cloth.

	Registration Roller
	Use a dry, lint-free cloth.

	Transfer Roller
	Use a dry, lint-free cloth. Do not touch the roller with fingers.

	Fuser
	Use a water-dampened, lint-free cloth.

	Printer
	Cleaning cloth that is provided with the printer.


Printer Consumable Items Replacement

Table 6A-7 lists the replacement intervals for printer consumable items and the control panel messages that display when each item needs to be replaced.

Table 6A‑7.  Printer Consumables Items Replacement Schedule

	Consumable
	Printer Message
	Page Count
	Approximate Time Period**

	Black Toner Cartridge
	BLACK TONER LOW or BLACK TONER OUT
	9,000 pages*
	4 months

	Cyan Toner Cartridge
	CYAN TONER LOW or CYAN TONER OUT
	6,000 pages*
	2.5 months

	Magenta Toner Cartridge
	MAGENTA TONER LOW or MAGENTA TONER OUT
	6,000 pages*
	2.5 months

	Yellow Toner Cartridge
	YELLOW TONER LOW or YELLOW TONER OUT
	6,000 pages*
	2.5 months

	Drum Kit
	DRUM LIFE OUT REPLACE KIT or WASTE TONERFULL REPLACE KIT
	6,250 color pages*** or 25,000 black-and-white only pages.
	3 months for color pages or 12.5 months for black-and-white only pages.

	Transfer Kit
	TRANSFER LIFE OUT REPLACE KIT
	25,000 color pages or 100,000 black-and-white only pages.
	12.5 months for color pages or 50 months for black-and-white only pages.

	Fuser kit
	FUSER LIFE OUT REPLACE KIT
	50,000 color pages or 100,000 black-and-white only pages.
	25 months for color pages or 50 months for black-and-white only pages


*
The approximate average A4/letter-size page count is based on 5% coverage of individual toner colors. Page counts are only estimates - usage conditions and print patterns can cause results to vary. 

**
Approximate lifespans are based on 2,000 pages per month. 

***
The 6,250 color pages or 25,000 black-only pages based on two-page,  one-sided, A4/letter-size print jobs. Actual number of pages will vary depending on individual customer usage. Factors affecting page yield includes color versus black-only printing mix, paper size, typical job length and complexity, and automatic duplexing (printing on both sides).

Locating Consumable Items

The locations of the consumable items are shown in the Figure 6A-5 below and described in Table 6A-8.
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Figure 6A-5.  Consumable Item Locations

Table 6A‑8.  Consumable Item Locations

	Item
	Description

	1
	Toner Cartridges

	2
	Imaging Drum Cartridge

	3
	Transfer Belt

	4
	Air Filters

	5
	Fuser

	6
	Transfer Roller


Replacing Consumable Items

6A.3.3.1 To clean the Toner Density Sensor

The toner density sensor should be cleaned whenever the imaging drum is replaced or whenever the control panel message DENSITY SENSOR OUT OF RANGE displays.

CAUTION:  To avoid scratching the sensor, do not clean it with any paper products.

To clean the Toner Density Sensor, perform the following procedures:

1.
Open the lower front drawer; remove the cleaning brush (refer to Figure 6A-6 that is mounted inside, and then close the drawer.
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Figure 6A-6.  Toner Density Sensor Cleaning Brush Location

2.
Pull open the top front drawer.

3.
Grasp the blue handle, and then pull up to remove the Imaging Drum (refer to Figure 6A-7).
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Figure 6A‑7.  Imaging Drum Removal

4.
Use the cleaning brush to remove all dust and toner particles from the sensor (refer to Figure 6A-8).
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Figure 6A‑8.  Toner Density Sensor Dust and Toner Removal

5.
Replace the Imaging Drum (refer to Figure 6A-9).
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Figure 6A‑9.  Imaging Drum Replacement

6.
Close the top front drawer.

7.
Replace the cleaning brush, and then firmly close the lower front drawer.

6A.3.3.2 To remove and replace the Toner Cartridges

Remove and replace the Toner Cartridge when the Control Panel displays the message “TONER CMYK OUT”.  The display can indicate that one or more toner colors are out.

To remove the Toner Cartridges, perform the following procedures:

1.
With the printer turned On and warmed up, push the dark gray release button on the side of the printer, and then open the top cover of the printer.

2.
Lift the flap that covers the Toner Cartridge slot, and then remove the used Toner Cartridge.

CAUTION:  Do not shake the Toner Cartridges after removing them.

To replace the Toner Cartridges, perform the following procedures:

1.
Position the new Toner Cartridge over the cartridge slot so that the blue arrow on the Toner Cartridge points to the blue arrow on the printer. 

2.
Make sure that the tab on the other end of the Toner Cartridge aligns with the notch on the cartridge slot.

NOTE:  If the tab does not fit in the notch when inserting the new Toner Cartridge, the toner is the wrong color for that cartridge slot.

3.
Slide the new Toner Cartridge down into the slot until the cartridge stops. 

4.
Rotate the new Toner Cartridge toward the back of the printer  (within the cartridge slot) until the cartridge stops.  The cartridge shutter opens to reveal the developer sleeve. 

5.
Lower the flap that covers the Toner Cartridge, and then close the top cover of the printer.

NOTE:  You must close the top cover before installing another Toner Cartridge.

6A.3.3.3 To remove and replace the Imaging Drum

Remove and replace the Imaging Drum when the printer Control Panel displays the message “REPLACE DRUM KIT”.

To remove and replace the Imaging Drum, perform the following procedures:

1.
Open the upper-front drawer of the printer, and then remove the used Imaging Drum. 

2.
Locate the new Imaging Drum.  Align it over the drawer so that the arrow on top points to the rear of the printer and the blue end cap on the side fits into the slot identified by the blue arrow.

NOTE:  Exposing the drum to light for more than 30 seconds can damage the drum.

3.
Slide the Imaging Drum down into place, and then close the drawer.

6A.3.3.4 To remove and replace the Transfer Kit

Remove and replace the transfer kit when the printer Control Panel displays the message “TRANSFER KIT OUT REPLACE KIT”.  The transfer kit consists of an intermediate Transfer Belt (ITB), a Transfer Roller, two Air Filters, and a Hand Wipe.

To remove and replace the Transfer Kit, perform the following procedures:

1.
Open the middle-front drawer of the printer.  

2.
Remove the used Transfer Belt by pulling up on the green handles that are located on its sides. 

3.
Locate the Transfer Roller inside the printer. 

4.
To unlock the used Transfer Roller, gently push down and back on the colored labels that are on the lower corners of the flap that is located in front of the roller. 

5.
Remove the used Transfer Roller by lifting it up and then out.

CAUTION:  Avoid touching the foam portion of the roller. Oil from fingers can affect the print quality.

6.
Place the new Transfer Roller in the notches behind the roller flap. 

7.
Lock in the new Transfer Roller by gently pushing down on both ends of the roller. 

8.
Remove the new Transfer Belt from its bag.

9.
Align the blue pins on both sides of the new Transfer Belt with the blue slots in the drawer, and then slide the Transfer Belt down into place.

10.
Close the middle front drawer. 

11.
To reset the printer for the new Transfer Kit, <Press> MENU on the Control Panel until “RESETS MENU” appears in the Control Panel Display. 

12.
<Press> ITEM until “TRANSFER KIT SELECT IF DONE” appears in the Control Panel Display, and then <Press> Select. 

13.
To replace the Air Filters, turn the printer Off, and then wait for the fans to stop running (approximately 10 minutes).

14.
Unplug the power cord, and then open the upper rear door of the printer. If the printer has a duplex-printing accessory, open the rear cover of the duplex-printing accessory. 

15.
Remove the two used Air Filters from the rear of the printer.

16.
Use the Hand Wipe to clean excess dust from the Fan areas.

17.
Insert the new air filters.

18.
Reconnect the power cord and turn the printer On.

6A.3.3.5 To remove and replace the Fuser Kit

Replace the fuser kit when the printer Control Panel displays the message ”FUSER LIFE OUT REPLACE KIT”.  The Fuser Kit contains one Fuser, four Paper Rollers, and a Hand Wipe.

To remove and replace the Fuser, perform the following procedures:
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WARNING:  To prevent possible burns, unplug the power cord, and then allow the printer to cool for 30 minutes.

1.
Turn the printer Off and remove power cord.

2.
Open the upper-rear door of the duplex printer accessory, if attached. 

3.
Open the upper-rear door of the printer. 

4.
Release the straps from the rear door by squeezing the latches on the straps where the latches connect to the rear door. 

5.
Inside the back of the printer, near the bottom, locate the two blue latches on the Fuser. 

6.
Rotate the two blue latches upward 90 degrees. 

7.
Grasp the finger holds on the Fuser, and then pull the used Fuser out of the printer. 

8.
Remove the new Fuser from its bag by using the finger holds.  Holding the new Fuser by the finger holds, slide the Fuser into the printer.

CAUTION:  The blue latches will lock only if the fuser is installed.

9.
Lock the Fuser in place by rotating the two blue latches down.  Reconnect the support straps to the upper rear door.

To remove and replace the Paper Rollers, perform the following procedures:

1.
Remove Tray 2 from the front of the printer. 

2.
On Tray 2, locate the Paper Roller and the cover next to the roller. 

3.
Squeeze the cover release lever, and then open the cover. 

4.
Remove the old Paper Roller from Tray 2 by squeezing together the blue tabs, and then sliding the roller off its spindle.

NOTE:  The feed roller has a D-shaped hub, and the separation roller has a round-shaped hub.

5.
Install a new Paper Roller on Tray 2.  Slide the new roller onto the spindle until the roller clicks into place. 

6.
Close the cover. 

7.
Inside the tray cavity on the printer, locate the Paper Roller in the top of the tray cavity. 

8.
Squeeze the blue tabs on the roller and then remove the old Paper Roller from the tray cavity. 

9.
Install a new Paper Roller on the tray cavity.  Slide the new roller onto the spindle until the roller clicks into place. 

10.
Replace Tray 2. 

11.
If using the optional 500-sheet paper feeder (Tray 3), repeat steps 3 through 9 to replace the two Paper Rollers for Tray 3.

NOTE:  Remove the Paper Roller in the tray cavity for Tray 3 in the opposite direction from the Paper Roller in the other tray cavity.

12.
Reconnect power cord and turn the printer On.  When the printer Control Panel displays “READY”, <Push> MENU on the Control Panel until “RESET MENU” appears. 

13.
<Press> ITEM until “NEW FUSER KIT, SELECT IF DONE” appears, and then <Press> Select. 

14.
To return the printer to “READY”, <Press> GO.

2

	Remove and Replace LRUs

  See Another Document
	For the interconnect information on LRUs, use the OASIS Site Drawing Package for your location.


6A.3.3.6 To remove and replace Color Printer

1.
Ensure that the Printer Power is Off and remove the power cable from the back of the unit.

2.
Remove the paper from the paper trays and set them aside.

3.
Remove the Toner Cartridges and set them aside.

4.
Remove the Ethernet (Network) Cable from the back of the Printer.
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WARNING:  The Color Printer unit weighs approximately 105 lbs.  Removing the Printer requires a 4 person lift.

5.
Unpack the replacement Printer and Ensure that it contains an Ethernet Network Card.  If not, remove the Network Card from the old Printer and replace it on the new printer, using the Remove and Replace the Ethernet Network Card procedure.

6.
Install the Ethernet Cable onto the replacement Printer.

7.
Install the Toner Cartridges removed from the old Printer.

8.
Add paper to the trays and install them.

CAUTION:  To protect the Printer from a power surge, make sure the power switch is in the Off position before plugging in the power cord.

9.
Connect the Power Cable onto the back of the replacement Printer and  power-on the replacement unit.

10.
Perform the Printer Tests and the Operational Verification.  The Printer should already be configured from the Depot.  If any problems are encountered attempt to print a “Configuration Page” to verify the Printer setup.

6A.3.4 Testing/Verification

Operational Verification

To ensure that the Color Printer is operational, print a Configuration Page.  To check the operation of the Printer through the Network (LCN), use WIND to print a weather image from an AFSS Workstation.

6A.3.4.1 To test the Color Printer using the Network

1.
Ensure that the Printer is ON and that the “READY” message is displayed on the control panel. 

2.
At an AFSS Workstation, <Double-click> the WIND icon to open the WIND application.

3.
When the WIND window is displayed <Click> on the File menu and <Select> Current Products to display the Current Products dialog box.

4.
Within the Currents Products dialog box, <Select> a Class and Clipboards then <Click> the Display button to open a window and display a Weather Graphic product.

5.
When a Weather Graphic product is displayed, <Click> the File menu and <Select> Print to display the Print dialog box.

6.
Within the Print dialog box, <Click> on the  (down arrow) of the Name drop-down list box and <Select> cprinter 4450 to choose the Tektronix Color Printer.

7.
With cprinter as the selected printer, <Click> the OK button to print the Weather Graphic product to the Color Printer.

8.
Ensure that the Graphic was printed to verify that the Color Printer is operational using the LCN.

 XE "Fault Isolation" Fault Isolation Checklist

As an aid in troubleshooting refer to Table 6A-10 which lists the normal problems /Error Message and solutions.

Table 6A‑9.  Troubleshooting Checklist

	Problem or Error Message
	Solution

	The control panel display is blank
	Make sure the printer’s power switch is On

The printer may be in PowerSave mode.  <Press> GO to check.

Make sure all power cables are securely attached and plugged into a grounded power outlet.  Verify that the short cable on the back of the duplex printing accessory is connected to the printer and that the power cord is connected correctly between the optional duplex printing accessory and the outlet.

	The control panel displays “OFFLINE”.
	<Press> GO.

	Cannot print from the computer using a parallel cable.
	The cable might be bad or installed incorrectly, or might be too long.  Remove the cable and reconnect it, making sure it is securely connected.  Try another bi-directional parallel cable  (IEEE-1284 compliant) with a “C-size” connector under 10 m  (32 ft) in length.

There may be a bad port on the computer or printer.  Try using a different port, or, if possible, a different computer or printer to help isolate the problem.

	Cannot print using a sharing (switchbox) device.
	Remove the sharing device to isolate the cause of the problem.  Test the printer using a cable connected directly from the computer to the printer

	Random “garbage” characters are printing.
	The cable might be bad or installed incorrectly, or might be too long.  Remove the cable and reconnect it, making sure it is securely connected.  Try another bidirectional parallel cable  (IEEE-1284 compliant) with a “C-size” connector under 10 m  (32 ft) in length.

There may be a bad port on the computer or printer. Try using a different port, or, if possible, a different computer or printer to help isolate the problem.

	Control panel displays “13.X PAPER JAM”.
	Paper may be jammed in one of several locations.  Clear all jams. 

Make sure packing spacers are removed from all media trays.

	Control panel displays an error message.
	Turn the printer Off and back On.

	Cannot find the printer in the network 

– OR –

The Configuration Page indicates an “I/O CARD NOT READY” message. 
	Verify cabling connections.

Ensure all configuration parameters are correct.


Testing Procedures

6A.3.4.2 To “ping” the Color Printer

To check the Ethernet Port and the cable to the Color Printer, ping the Printer from the Maintenance Position.

1.
At the Maintenance Position (NT Server 2),  <Click> the Start button and select Start>Programs>Command Prompt to open the Command Prompt dialog box.

2.
At the “C:\>” prompt, <Type> ping xxx.xxx.xx.11 (where the x’s equals the site ip address and .11 represents the color printer ip address) to ping the Color Printer.


If the Ethernet Port and the connection to the device under test are operational., the system should respond three times with the correct IP Address and the number of bytes transferred.


If the system responds with a “timeout”, recheck the device’s IP address and the network connections.

3.
Upon the completion of using the Command Prompt window,  <Type> exit at the “C:\>” prompt to return to the Windows Desktop.
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